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ABSTRACT 

This study aims to identify the condition of drainage channels 

located along Jalan Pangeran Antasari in Samarinda City and to present 

the data interactively through a WebGIS platform. Drainage issues in 

this area often cause waterlogging and flooding during heavy rainfall. 

Therefore, accurate and accessible mapping of drainage conditions is 

crucial. The research method involved physical measurements of 

drainage dimensions, such as top width, bottom width, channel height, 

and concrete width. The collected data were processed using ArcGIS Pro 

software by digitizing the drainage paths in the form of polylines, which 

were then published through ArcGIS Online in a dashboard format. 

Field documentation was also supported by geo-tagged photos that were 

converted into coordinate points on the map. The findings of the study 

revealed that several drainage segments have inadequate dimensions to 

accommodate stormwater during heavy rain, indicating the need for 

improvement or normalization. The developed WebGIS successfully 

presents spatial and descriptive information about the drainage 

conditions in an interactive format, making it a valuable reference for 

technical evaluation and drainage management planning in the area 
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1. PENDAHULUAN  

Kota Samarinda adalah salah satu daerah perkotaan 

di Kalimantan Timur yang sering terdampak banjir, 

khususnya saat periode hujan. Cakupan wilayah banjir 

masih tersebar di seluruh kota. Untuk itu diperlukan 

strategi peningkatan pegendalian banjir di Kota 

Samarinda agar permasalahan banjir dapat diatasi 

(Pratiwi & Ndraha, 2018).  

Banjir adalah peristiwa tergenangnya daratan yang 

biasanya kering oleh karena volume air pada suatu 

badan air meningkat. Banjir dapat terjadi karena 

peluapan air yang berlebihan di suatu tempat akibat 

hujan besar, pecahnya bendungan sungai, es yang 

mencair atau naiknya permukaan laut. Banjir menjadi 

suatu bencana ketika terjadi pada daerah yang 

merupakan tempat aktifitas manusia. Perubahan 

tataguna lahan, pemanasan global, serta air pasang 

yang tinggi mempercepat terjadinya banjir di beberapa 

tempat termasuk di Indonesia (Razikin dkk., 2017).  

Kawasan rawan banjir merupakan kawasan yang 

sering atau berpotensi tinggi mengalami bencana banjir 

sesuai karakteristik penyebab banjir. Kawasan tersebut 

dapat dikategorikan menjadi empat tipologi yakni 

daerah pantai, daerah dataran banjir, daerah sempadan 

sungai, dan daerah cekungan (Abast dkk., 2016).  
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Salah satu lokasi yang rawan adalah Jalan Pangeran 

Antasari, yang menjadi jalur utama bagi kegiatan 

masyarakat dan transportasi. Meskipun terdapat upaya 

pembangunan seperti polder untuk mengontrol banjir, 

masalah genangan dan banjir belum sepenuhnya 

teratasi. Hal ini salah satunya disebabakan karena 

sistem drainase di kawasan ini masih belum berfungsi 

secara optimal. 

Sistem drainase Kota Samarinda saat ini masih 

belum sesuai dengan standar sistem drainase kota yang 

baik. Beberapa saluran juga sudah mengalami 

kerusakan. Permasalahan banjir yang terjadi di Kota 

Samarinda disebabkan adanya luapan air yang tidak 

mampu tertampung pada daerah hulu dan saluran 

drainase, sehingga aliran air bergerak menuju wilayah 

yang lebih rendah (Riswan dkk., 2025). 

Saluran drainase merupakan salah satu komponen 

infrastruktur yang penting untuk menyalurkan 

kelebihan air. Meningkatnya limpasan karena 

berkurangnya daerah resapan air dapat diatasi dengan 

pembangunan saluran drainase yang memadai, yang 

dapat mengalirkan kelebihan air. Saat ini keberadaan 

sistem drainase merupakan salah satu penilaian 

infrastruktur perkotaan yang sangat penting. Kualitas 

manajemen suatu kota dapat dilihat dari kualitas sistem 

drainase yang ada (Ekananda dkk., 2019).  

Secara umum sistem drainase dapat didefinisikan 

sebagai serangkaian bangunan air yang berfungsi untuk 

mengurangi dan membuang kelebihan air dari suatu 

kawasan atau lahan, sehingga lahan dapat difungsikan 

secara optimal. Dilihat dari hulunya, bangunan sistem 

drainase terdiri dari saluran penerima (interceptor drain), 

saluran pengumpul (collector drain), saluran pembawa 

(conveyor drain), saluran induk (main drain) dan badan 

air penerima (receiving waters). Di sepanjang sistem 

sering dijumpai bangunan lainnya, seperti gorong 

gorong, siphon, jembatan air (aquaduct), pelimpah, 

pintu-pintu air, bangunan terjun, kolam tandon dan 

stasiun pompa. Pada sistem yang lengkap, sebelum 

masuk ke badan air penerima, air diolah dahulu pada 

Instalasi Pengolahan Air Limbah (IPAL), khususnya 

untuk sistem tercampur. Hanya air yang telah 

memenuhi baku mutu tertentu yang dimasukan ke 

badan air penerima, sehingga tidak merusak 

lingkungan (Maulidin dkk., 2023). 

Pemilihan daerah untuk penelitian ini yakni pada 

Drainase Jalan Pangeran Antasari, Kecamatan 

Samarinda Ulu, Kota Samarinda didasarkan pada 

tingginya frekuensi kejadian banjir, aktivitas ekonomi 

yang intensif, serta dampak sosial yang signifikan. 

Permasalahan yang paling utama diketahui adalah 

kondisi saluran drainase yang tidak mencukupi untuk 

menampung aliran air hujan, yang disebabkan oleh 

beberapa faktor teknis seperti dimensi saluran (lebar, 

tinggi, dan kedalaman), sedimentasi yang menghambat 

aliran air, kerusakan pada struktur saluran, minimnya 

pemeliharaan dan pembersihan, serta kurangnya data 

spasial yang terintegrasi untuk menganalisis penyebab 

banjir. Faktor-faktor ini perlu dianalisis karena 

langsung memengaruhi kinerja sistem drainase dalam 

mengalirkan air limpasan.  

Elemen teknis seperti dimensi saluran dan 

keberadaan sedimen tidak hanya bersifat fisik, tetapi 

juga berpengaruh pada perencanaan tata ruang dan 

mitigasi bencana di perkotaan. Informasi mengenai 

keadaan nyata dari sistem drainase ini sangat 

diperlukan oleh Dinas Pekerjaan Umum sebagai 

pengelola infrastruktur kota, Badan Penanggulangan 

Bencana Daerah (BPBD) untuk penilaian risiko banjir, 

Pemerintah Daerah dalam membuat kebijakan 

pembangunan, serta masyarakat umum untuk 

memahami daerah yang rentan terhadap banjir dan 

berkontribusi dalam menjaga saluran. 

Guna memastikan akses informasi penelitian cepat, 

jelas, dan interaktif, hasil penelitian ini disajikan dalam 

bentuk Sistem Informasi Geografis (SIG) berbasis web 

atau dikenal juga dengan istilah WebGIS. SIG 

merupakan sistem komputer yang digunakan untuk 

mengumpulkan, memeriksa, mengintegrasikan, dan 

menganalisa informasi-informasi yang berhubungan 

dengan permukaan bumi yang disajikan dalam bentuk 

peta (Wibowo dkk., 2015). SIG merupakan sistem 

geospasial yang berperan penting dalam perencanaan 

pembangunan. SIG sebagai sistem yang mampu 

mengakomodasi data spasial dengan data atribut 

menjadi sebuah tampilan yang mampu memberikan 

analisis keruangan, dapat digunakan untuk 

memberikan informasi dalam perencanaan 

(Kurniawati dkk., 2020). 

Sementara itu, WebGIS merupakan aplikasi 

Geographic Information System (GIS) yang dapat 

diakses secara online melalui internet/web. Pada 

konfigurasi WebGIS ada server yang berfungsi sebagai 

MapServer yang bertugas memproses permintaan peta 

dari client dan kemudian mengirimkannya kembali ke 

client. Dalam hal ini pengguna tidak perlu mempunyai 

software GIS, pengguna hanya menggunakan internet 

browser seperti Internet Explorer, Mozilla FireFox, 

Microsoft Edge, atau Google Chrome untuk mengakses 
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informasi GIS yang ada di server (Fariza dkk., 2024). 

WebGIS berfungsi mendistribusikan, 

mempublikasikan, mengitegrasikan, 

mengkomunikasikan dan menyediakan informasi 

dalam bentuk teks dan peta digital serta mejalankan 

fungsi-fungsi analisis dan query yang terkait dengan 

GIS melalui jaringan internet (Putri & Yulfa, 2024). 

Melalui WebGIS, para pemangku kepentingan bisa 

melihat peta kondisi saluran dalam konteks spasial, 

mengakses dokumentasi foto saluran, menemukan 

lokasi-lokasi kritis yang perlu diperbaiki, dan 

mengambil keputusan berdasarkan data visual serta 

spasial yang akurat. Dengan metode ini, penelitian 

tidak hanya berfungsi sebagai catatan teknis, tetapi juga 

sebagai media komunikasi publik yang mendukung 

pengambilan keputusan berbasis data. Berdasarkan 

latar belakang yang diuraikan di atas, maka rumusan 

masalah dalam penelitian ini adalah, bagaimana 

kondisi drainase di jalan Pangeran Antasari Kota 

Samarinda; dan bagaimana merancang informasi 

spasial mengenai kondisi drainase berbasis web di Jalan 

Pangeran Antasari Kota Samarinda? Adapun Tujuan 

penelitian ini adalah untuk mengidentifikasi kondisi 

drainase di jalan Pangeran Antasari Kota Samarinda 

dan menyajikan informasi tersebut dengan platform 

WebGIS. 

2. METODE 

2.1. Lokasi dan Waktu 

Lokasi penelitian dilaksanakan di Jalan Pangeran 

Antasari, Kota Samarinda, jalan ini memiliki panjang 

sekitar 1.73km. Lokasi dipilih dikarenakan di Jalan 

Pangeran Antasari Kota Samarinda yang masih 

memiliki tingkat kerentanan banjir yang lumayan 

tinggi. 

 
Gambar 1. Lokasi Penelitian 

2.2. Alat dan Bahan 

a. Alat  

Adapun alat dan bahan yang digunakan dalam 

pelaksanaan penelitian ini sebagai berikut: 

1) Alat tulis, digunakan untuk mencatat dan 

menggambar dimensi drainase. 

2) Handphone, digunakan untuk pengambilan data 

dokumentasi. 

3) Software ArcGIS Pro, digunakan untuk 

membuat jalur drainase di lokasi penelitian. 

4) Roll Meter, digunakan untuk mengukur dalam, 

lebar atas, lebar bawah, lebar beton saluran. 

5) Microsoft excel, digunakan untuk memasukkan 

data keterangan saluran 

b. Bahan 

Bahan yang digunakan dalam kegiatan 

penelitian ini adalah sebagai berikut: 

1) Data dimensi Saluran di jalan Pangeran Antasari 

tahun 2025 

2) Dokumentasi lapangan 

3) Data topografi jalan Pangeran Antasari pada 

tanggal 28 Januari 2025 - 1 Februari 2025 

2.3. Pengolahan data 

Dalam penelitian ini langkah kerja yang dilakukan 

sebagai berikut: 

a. Memasukkan Data Inventarisasi dan Dokumentasi 

Tahap ini, data hasil dari inventarisasi dan 

dokumentasi yang sudah diambil dari lapangan 

akan dimasukkan ke software ArcGIS Pro untuk 

diolah. 

b. Geotagged to Point 

 
Gambar 2. Proses Geotagged to Point 

Tahap ini bertujuan untuk mengkonversi 

foto yang memiliki in-formasi geotag 

(koordinat gps) menjadi point pada peta. Setiap 

point mewakili lokasi dimana foto tersebut 



 

 

CONTACT Shabri Indra Sulyalfihra 📧 shabri.indra@politanisamarinda.ac.id 

© 2025 The Author(s). Published by Tanesa Press, Politeknik Pertanian Negeri Samarinda. 
This is Open Access article distributed under the terms of the Creative Commons Attribution License (http://creativecommons.org/ 
licenses/by/4.0/), which permits, unrestricted use, distribution, and reproduction in any medium, provided the original work is properly 
cited. 

- 4 - 

diambil. Tahap-tahap membuat geotagged to 

point yakni Analysis->Tools->GeoTagged to Points. 

c. Membuat Polyline untuk Membentuk Jalur 

Drainase 

 
Gambar 3. Proses Membuat Jalur Polyline 

Pada tahap ini, membuat polyline dan 

melakukan digitasi di sepan-jang jalan Pangeran 

Antasari kota Samarinda untuk memetakan jalur 

drainase nya, Tahap-tahap membuat polyline, 

Catalog pane->folder geodatabase->new->feature 

class->feature class type->finish. 

d. Membagi Garis dengan Kriteria Tertentu 

 
Gambar 4. Proses Split Polyline 

Setelah dilakukan digitasi polyline, selanjutnya 

gunakan fitur split tool untuk membagi panjang 

dengan kriteria tertentu, karena setiap pem-bagian 

garis memiliki keterangan, contohnya yaitu lebar 

bawah, lebar atas, lebar beton, lebar drainase, dalam 

drainase. Tahap-tahap membuat split, Edit->Tools-

>Split. 

 

 

 

 

 

 

e. Memasukkan Data Dimensi Drainase ke Attribute 

Table 

 
Gambar 5. Proses Memasukkan Data Dimensi 

Saluran ke Data Attribute Table 

Tahap ini untuk memasukkan ukuran dimensi 

drainase yang terdiri dari lebar bawah, lebar atas, 

lebar beton, lebar drainase, dalam drainase ke dalam 

kolom di Attribute table. berikut adalah tahap-tahap 

memasukkan data dimensi drainase ke dalam data 

attribute table. 

f. Pembuatan Web Layer 

 
Gambar 6. Proses pembuatan web layer 

Pembuatan web layer adalah tahapan untuk 

mempublikasikan ke ArcGIS online. Tahap-tahap 

pembuatan Web Layer yakni, Share->Web map-

>Share as web map->Analyze->Share 

g. Buka ArcGIS online 

 
Gambar 7. Proses Publikasi 
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Tahapan ini untuk memproses menyimpan, 

mengelola, dan menyajikan data spasial dalam 

bentuk web. Berikut adalah tahap-tahap membuka 

ArcGIS online 

Buka google chrome->Search “ArcGIS Online”-

>Organisasi->Konten terbaru->pilih titik 9 di 

sebelah kanan atas->pilih ArcGIS Dashboards 

h. Publikasikan ArcGIS dashboard ke Publik 

Tahapan ini untuk mempublikasikan webgis ke 

semua orang(everyone) tanpa harus login ke akun 

ESRI. Berikut adalah tahap-tahap mempublikasikan 

dari ArcGIS dashboard untuk bisa diakses oleh 

publik. 

 
Gambar 8. Proses Penyalinan Link URL Untuk 

Dipublish Ke Publik 

ArcGIS dashboard-> Pilih map yang akan 

dipublikasikan->Atur widget seperti elemen, 

legenda > Save-> Kembali ke ArcGIS dashboard-> 

klik kanan pada map yang dipilih-> copy link 

address-> Share ke publik 

3. HASIL DAN PEMBAHASAN 

Penelitian ini menghasilkan sistem WebGIS 

interaktif yang menggambarkan kondisi saluran 

drainase di sepanjang Jalan Pangeran Antasari, Kota 

Samarinda. Melalui proses pengumpulan data 

lapangan, seperti dimensi fisik saluran (lebar atas, lebar 

bawah, tinggi, dan lebar beton). Hasil pengukuran 

dimensi saluran tersaji pada Tabel 1. 

Tabel 1. Tabel Hasil Pengukuran Dimensi Saluran 

 

Berdasarkan data dari inventarisasi saluran drainase 

di Jalan Pangeran Antasari, Kota Samarinda, terdapat 

variasi ukuran fisik saluran yang cukup berbeda di 

setiap titik pengamatan. Lebar atas saluran yang 

tercatat berada dalam rentang antara 120 cm sampai 

170 cm, dan ukuran yang paling banyak ditemui adalah 

antara 130 cm sampai 160 cm. Lebar atas yang lebih 

lebar biasanya menunjukkan kemampuan saluran 

untuk menampung lebih banyak air hujan. Lebar 

bawah saluran, bagian dasar di mana air mengalir, 

memiliki ukuran antara 110 cm sampai 150 cm. 

NAMA SALU-
RAN 

LEBAR 
ATAS 

LEBAR 
BAWA

H 

TEBAL 
BETON 

KIRI 

TEBAL 
BETON 
KANAN 

DALAM 
SALURAN 

KONDISI 
DRAINASE 

Simpang 3 
cendana 

160c
m 

150cm 20cm 20cm 100cm BAIK 

SIMPANG 
MUARA KIRI 

170c
m 

 - 20cm 40cm 65cm 
TIDAK 
BAIK 

Simpang 4 
Antasari 

120c
m 

110cm - 25cm 50cm 
TIDAK 
BAIK 

Seberang DIY 
135c

m 
125cm 20cm 20cm 70cm BAIK 

Gg Mawar 
130c

m 
120cm 20cm 20cm 70cm BAIK 

Gg kenanga 
340c

m 
330cm 25cm 25cm 220cm BAIK 

Gg Mawar 
130c

m 
120cm 20cm 20cm 70cm BAIK 

Citra Jaya 
Mebel 

370c
m 

360cm 25cm 30cm 150cm BAIK 

Kaltim Ventura 
320c

m 
310cm 25cm 25cm 230cm BAIK 

Dealer 
Yamaha 

320c
m 

310cm 15cm 15cm 230cm BAIK 

Dealer suzuki 
360c

m 
350cm 60cm 10cm 100cm BAIK 

Seberang 
Mixue Anta-

sari 

385c
m 

375cm 20cm 15cm 100cm BAIK 

Seberang In-
domaret 1 

360c
m 

350cm 20cm 25cm 100cm BAIK 

Seberang Tirta 
mahakam 

205c
m 

195cm 20cm 20cm 75cm BAIK 

Depan Yube 
Snakers 

200c
m 

190cm 20cm 20cm 70cm BAIK 

Seberang Sta-
tion 

200c
m 

190cm 16cm - 60cm BAIK 

Seberang 
Halte 

200c
m 

190cm 18cm 17cm 75cm BAIK 

Simpang 
cendana 2 

190c
m 

180cm 15cm 17cm 115cm BAIK 

Sbrg_surya-
phone 

170c
m 

150cm 20cm 60cm 80cm BAIK 

Depan Talago 
150c

m 
140cm 20cm 20cm 25cm BAIK 

Sebrang 
Moodzy 

130c
m 

120cm 10cm 20cm 50cm BAIK 
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Tabel 2. Tabel Hasil Pengukuran Topografi 

 
Penelitian ini bertujuan untuk mengidentifikasi 

kondisi saluran drainase di Jalan Pangeran Antasari, 

Kota Samarinda, yang sering mengalami banjir saat 

musim hujan. Kondisi drainase yang tidak memadai, 

seperti dimensi saluran yang tidak ideal, sedimentasi, 

serta kurangnya pemeliharaan, menjadi penyebab 

utama masalah genangan di kawasan ini. Untuk 

mengatasi hal tersebut, penelitian ini menggunakan 

teknologi WebGIS yang dirancang melalui perangkat 

lunak ArcGIS Pro dan dipublikasikan secara interaktif 

menggunakan ArcGIS Online. 

Data yang digunakan dikumpulkan melalui 

pengukuran langsung di lapangan, seperti lebar atas dan 

bawah saluran, kedalaman, serta dokumentasi visual 

dengan koordinat geotag. Hasil pengukuran 

menunjukkan bahwa beberapa saluran memiliki 

kapasitas yang cukup, namun sebagian lainnya 

mengalami pendangkalan atau kerusakan struktur, 

sehingga tidak mampu mengalirkan air dengan baik 

saat curah hujan tinggi. Gambar penampang (cross 

section) pada berbagai titik STA memperlihatkan 

variasi elevasi dan kedalaman saluran, yang 

menunjukkan perlunya perencanaan drainase yang 

disesuaikan dengan kondisi topografi setempat. 

Melalui platform WebGIS, informasi kondisi 

saluran dapat diakses secara spasial dan deskriptif oleh 

berbagai pihak, seperti pemerintah daerah, dinas 

terkait, hingga masyarakat umum. Dengan penyajian 

data yang interaktif dan visual, diharapkan 

pengambilan keputusan dan perencanaan perbaikan 

dapat dilakukan secara lebih cepat dan tepat sasaran. 

4. KESIMPULAN 

Penelitian ini telah berhasil merancang sistem 

WebGIS yang mampu menampilkan informasi kondisi 

saluran drainase secara interaktif di Jalan Pangeran 

Antasari, Kota Samarinda. Sistem ini dikembangkan 

menggunakan ArcGIS Pro dan dipublikasikan dalam 

bentuk dashboard melalui ArcGIS Online. WebGIS 

yang dibuat menyajikan data spasial dan atribut seperti 

dimensi saluran, elevasi, dan dokumentasi lapangan 

berupa foto geotag, sehingga memudahkan pengguna 

dalam memahami kondisi fisik drainase secara 

menyeluruh) 

Selanjutnya, penelitian ini juga berhasil memetakan 

dan menganalisis kondisi aktual saluran drainase 

berdasarkan hasil pengukuran di lapangan. Ditemukan 

adanya perbedaan ukuran dan kondisi saluran pada 

beberapa titik, termasuk segmen yang mengalami 

pendangkalan atau tidak sesuai dimensi ideal. Hal ini 

menunjukkan bahwa meskipun sebagian besar saluran 

masih berfungsi, beberapa bagian perlu dilakukan 

perbaikan agar sistem drainase dapat berfungsi optimal 

dan mencegah potensi banjir lokal di kawasan tersebut 
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